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Copyright © 2022 Optiwave, All rights reserved.

All OptiFDTD documents, including this one, and the information contained therein, are copyright 
material. No part of this document may be reproduced, stored in a retrieval system, or transmitted 
in any form or by any means whatsoever, including recording, photocopying, or faxing without prior 
written approval of Optiwave.

Disclaimer

Optiwave makes no representation or warranty with respect to the adequacy of this documentation 
or the programs which it describes for any particular purpose or with respect to its adequacy to 
produce any particular result. In no event shall Optiwave, its employees, its contractors or the 
authors of this documentation, be liable for special, direct, indirect, or consequential damages, 
losses, costs, charges, claims, demands, or claim for lost profits, fees, or expenses of any nature or 
kind.
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1 Installing OptiFDTD
Before installing OptiFDTD, ensure that the selected system meets the system requirements as 
described below.

1.1 Hardware and software requirements
OptiFDTD requires the following minimum system configuration:

Microsoft Windows 7, 8.1 or higher, or 10.
64 bit operating system and processor (Intel x64 or AMD64)
Personal computer with Pentium 4 or higher processor 1.2 GHz (or higher). Multi-core CPU is required for 
increased performance using parallel processing.
8 GB of RAM or higher (dependent on the size of calculated problem)
1 GB free hard drive disk space
1024 x 768 graphic resolution, 16-, 24-, or 32-bit DirectX and OpenGL capable graphics adapter

1.2 Protection key
A hardware protection key is supplied with the software. Note: Please ensure that the hardware 
protection key is NOT connected during the installation of OptiFDTD.

To ensure that OptiFDTD operates properly, verify the following:
The protection key is properly connected to the parallel/USB port of the computer.

Ensure that there is no conflict between the OptiFDTD protection key and any other hardware keys that may be 
installed.

1.3 OptiFDTD directory
By default, the OptiFDTD installer creates an OptiFDTD directory on your hard disk in the default 
location:

C:\Program Files\Optiwave Software\OptiFDTD 16 \

The OptiFDTD directory contains the following sub-directories:
\bin — executable files, dynamic linked libraries

Use a switch box to prevent protection key conflicts. Ensure that the cable between the 
switch box and the computer is no more than one meter in length.
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\doc — OptiFDTD support documentation

The documentation and executable files have shortcuts in the Windows Start  menu (or tiles in 
Windows 8). 

1.4 Installation
OptiFDTD can be installed on 64 bit versions of Windows 7, 8.1 or higher, or 10. It is recommended 
that all Windows programs are shut down before running the setup program.

To install OptiFDTD from a CD ROM, use the following procedure:

Log on as the Administrator, or log on using an account with Administrator privileges.
Insert the OptiFDTD installation CD into the CD ROM drive.
On the Taskbar, click Start and select Run.
The Run dialog box appears.
In the Run dialog box, type  F:\setup.exe , where F is your CD ROM drive.
Click OK and follow the screen instructions and prompts.
When the installation is complete, a reboot of the system will be required.

1.5 OptiFDTD samples
The samples installer runs directly after the end of the installation of the main OptiFDTD 
application. By default, the samples are installed under the  My Documents  directory in a folder 
named OptiFDTD 16 Samples. The default location can be changed in the installer.

If needed, samples can be re-installed by double-clicking the file OptiFDTD_Samples.exe  in the 
OptiFDTD 16 installation directory.

Additional samples and application cases can be found online. Simply select Help->Download 
Samples from OptiFDTD, or visit http://www.optiwave.com/optifdtd/ for more information.

1.6 Technical support

Phone             (613) 224-4700—Monday to Friday, 8:30 a.m. to 5:30 p.m. Eastern 
Standard Time

Fax  (613) 224-4706

http://www.optiwave.com/optifdtd
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2 Introduction to OptiFDTD

2.1 What are OptiFDTD and FDTD?
OptiFDTD is a powerful, highly integrated, user-friendly software that allows computer aided design 
and simulation of advanced passive photonic components.  The OptiFDTD software package is 
based on the finite-difference time-domain (FDTD) method. The FDTD method has been established 
as a powerful engineering tool for the simulation of integrated and diffractive optics devices. The 
method directly solves Maxwell's equations with no pre-processing assumptions allowing FDTD 
simulations to define a geometry, a source and detectors and simultaneously model propagation, 
scattering, diffraction, reflection, polarization effects. It can also model material anisotropy and 
dispersion without any assumptions on field behavior, such as the slowly varying envelope 
approximation. The method enables effective and powerful simulation capabilities and analysis of 
sub-micron devices with very fine structural details. A sub-micron scale implies a high degree of 
light confinement and correspondingly, a large refractive index difference of the materials to be 
used in a typical device design, a limitation of other numerical approaches.

1 A Yee cell. Magnetic field components are represented in blue, electric field components are shown in red.
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FDTD relies on the discretization of both space and time of the problem space. The coupled 
electromagnetic fields are discretized along the  a mesh comprised of Yee cells. Magnetic and 
electric field components are positioned in a staggered fashion on the edges of each cell. By 
calculating the finite difference between two field components on opposite edges of the cube, it is 
possible to obtain a second-order approximation of the spatial derivative of the field. Finite 
differences are used in the same way to approximate time-derivatives of the fields. The algorithm 
used to compute and update the simulation space for each time step the electric and magnetic 
fields is called the Yee algorithm. More details are given in the "Technical Background" manual. The 
accuracy of the solution to the computational problem should converge as the size of the space and 
time steps tend to zero. This added accuracy comes at the cost of computational resources in terms 
of the time required to complete a simulation and the memory required to store it.

Each cell within the simulation grid represents a small volume with set material properties. 
Materials in OptiFDTD can be of varied types:

isotropic and diagonally anisotropic dielectrics
dispersive materials using Drude, Lorentz, or Lorentz-Drude models
perfect conductors
nonlinear materials (2nd order, 3rd order, or Raman)

In addition to these materials, an FDTD simulation will require sources and detectors to be defined 
so that power can be injected into the mesh and fields fields can be monitored.  Fields can be stored 
as time varying or in frequency using Discrete Fourier Transforms (DFTs).

2.2  OptiFDTD workflow 
Creating and running an FDTD simulation using OptiFDTD can be accomplished using 4 main programs, described 
below:

OptiFDTD Designer - The main OptiFDTD program. From here, you can create new designs, set simulation 
parameters, write scripts and start simulations. Data is saved in a project file with the extension .fdt.
OptiFDTD Simulator - Opens automatically when a simulation is run from Designer and processes the project 
files in the fdt file in order to perform the simulation. Simulation results are stored in a file with the 
extension .fda.
OptiFDTD Analyzer - Loads and analyzes the result files produced by OptiFDTD Simulator (.fda). Contains 
extensive viewing options, analysis and post-processing features, and has the facilities to export data to other 
file formats.

A typical FDTD simulation design sequence can be defined as this: first define the simulation 
domain sizes, then define materials and profiles to be used in the simulation, then create the 
objects, light sources, and detectors that compose the simulation, run the simulation, and finally, 
analyze the results. The workflow of a typical simulation using OptiFDTD is shown below.
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2.3 OptiFDTD coordinate system
OptiFDTD uses a coordinate system typical of waveguiding applications in which the transverse axes are X  and Y 
while the Z axis is the axis of propagation.  The use of this particular coordinate system is based upon the need to 
ensure compatibility with other Optiwave software such as OptiBPM. A representation of the coordinate system 
used is shown below.
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The regions in Y that are above and below the XZ (Y=0) plane are named Substrate and Cladding, 
again matching traditional waveguide technology in which waveguides are fabricated on a 
Substrate. OptiFDTD does provide the ability to set the Substrate and Cladding regions to be 
different materials.

While working with OptiFDTD, it is necessary to take note of the following conventions:
    The XZ plane is the primary view in the Layout of the OptiFDTD Designer
    X is referred to as the width or vertical component
    Y is referred to as the depth
    Z is referred to as the length or horizontal component
    The 2D and 3D simulation domains are referred to as 2D and 3D wafers with their respective material 
properties defined in the corresponding tabs in the Wafer Properties form

 It is possible to run either 2D or 3D simulations using OptiFDTD. Note, that when running 2D 
simulations the simulation region is the XZ plane.
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3 Quick Start
This section will walk through the standard steps of working through an FDTD simulation:

Opening a sample project
Navigating the user interface and verifying/editing parameters
Running a simulation
Visualizing/Post-processing results

The example used in this section will be a ring resonator.  Included in the documentation is a series 
of lessons with more advanced designs at online examples3.  Additionally samples come with the 
installation package for review.

3.1 Starting OptiFDTD
Work related to the creation of designs and configuration of simulations is accomplished within 
the OptiFDTD Designer environment. To open the application, perform the following steps:

Open Windows Start Menu
Select Programs >  OptiFDTD 16.0 RC > OptiFDTD Designer.

OptiFDTD Designer loads and the main application window appears.

http://www.optiwave.com/optifdtd/
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2.

2 Main OptiFDTD Designer application window

3.2 Opening the sample ring resonator project file
To load the ring resonator sample file, perform the following procedure.

From the File menu, select Open.
Navigate to the user documents folder and select OptiFDTD 16 Samples > 2D_Samples > 
photonic_components > Getting_Started_Ring_Resonator.fdt
The ring resonator sample project opens in the main window
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3 Ring resonator sample project

The default view displayed in the Main window represents the ring resonator design in the XZ plane. 
A complete 3D view of the structure can be seen in the 3D Editor, which is activated through the 3D 
Editor tab in the view tabs.  The horizontal dimension corresponds to the Z axis, while 
the vertical dimension corresponds to the X axis.

The left frame is the Project browser. This is where all materials (all defined for this project), objects, 
sources, and detectors in use are displayed. Each node of the project browser represents an 
element. Parent elements can be collapsed or expanded by clicking the + or - sign next to their 
name. Right clicking on a node presents a contextual menu for either deleting the node or accessing 
its properties. The properties of a given element can be accessed by double-clicking the node. 

Below the Main window  is the Output window  which includes tabs for notifications from scripts 
(Notifications) and errors (Error).

The Toolbars are shortcuts to many functions of the software, such as creating objects and 
waveguides, resizing the view, selecting elements and display options. They can be activated or 
deactivated by right clicking in an empty area of the toolbar regions. All the functions present in the 
toolbars are also accessible via the Menu bar.  Toolbars are configurable in terms of their position, 
they can be moved through drag and drop functionality and will be stored for future sessions.
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The Status bar displays information on the position of the mouse cursor inside the layout and if the 
program is running calculation or ready for user input.

3.3 FDTD domain dimensions
The global dimensions of the FDTD calculation domain can through the wafer properties dialog:

Double-click on the node named Simulation Domain, under Global Properties in the project browser
The Wafer properties dialog opens.

OR
Select Edit > Wafer Properties from the Menu bar

4 Wafer properties dialog

Zoom functionality is available through the + and - buttons or the magnifying glass in the 
toolbars.
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In the Wafer Dimensions tab, the 2D dimensions (in microns) of the FDTD grid can be set:
Length defines the Z direction dimension of the grid
Width defines the X direction dimension of the grid

The background material for the 2D simulation is set In the 2D Wafer Properties tab, you can define 
the background material to use for the simulation. Any material that has been defined within this 
project can be assigned, for the purpose of this example this is set to the preset material Air.  If a 
material needs to be created this can be done from the Project Browser or from the Profile Designer
accessed through the Materials in Use...

3.4 Material properties

3.4.1 Opening the dielectric material properties
A material called Dielectric 2.5 has been defined and used as the material for the waveguide profile 
that will be used for the waveguides in this structure.  The Dielectric 2.5 material definition can be 
access through the following:

Double-click on the node named Dielectric 2.5 within the Materials node in the Project browser.

OR
Right-click on the Dielectric 2.5 material and select properties

The Dielectric 2.5 material properties dialog opens.



OptiFDTD Documentation – Getting Started

Quick Start– 16

•

5 Dielectric 2.5 material properties dialog

In this dialog, a basic dielectric material can be defined by its refractive index. The material can be 
isotropic or anisotropic and both the real value and imaginary values of the refractive index can be 
set in the boxes labeled Re and Im respectively.

3.4.2 Opening the profile properties
In OptiFDTD waveguides are defined as a path while the cross-sectional profile is defined in 
the Profiles section of the Project browser. To gain access to the waveguide profile properties 
proceed to the following:

Double-click on the node named ChannelPro1 of the Profiles node in the Project browser.

OR

•
•

The refractive index definition within OptiFDTD follows the engineering convention:
Im > 0 in the refractive index will model a material gain
Im < 0 in the refractive index will model a material loss



The refractive index defined here is only valid for the central wavelength of the light source 
used. For simulations using Sine-Modulated Gaussian Pulse waves, this will result in non 
physical representation of the material as the wavelength departs from the central 
wavelength. For more accurate models, taking into account chromatic dispersion, please 
consider using dispersive material definitions.
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Right-click on the ChannelPro1 profile and select properties

The ChannelPro1 dialog opens.

6 ChannelPro1 profile properties

In 2D simulations, the profile has only a material definition.  it can be seen that in the 2D profile 
definition list, the Dielectric 2.5 previously described is selected. If assigned material is changed the 
profile must be stored ( ). 

In 3D simulations it is necessary to define the layer structure of the waveguide.

3.5 Component Geometry (ring)

The geometrical properties of the ring can be accessed and modified in 3 different ways:
By double-clicking on the ring drawn in the Main window
By double-clicking on the node named Ring1 in the project browser
By right-clicking on the node named Ring1 in the project browser and selecting Properties
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7 Ring Waveguide properties dialog

The tab on the top of the dialog, named Center, is used to define the position of the center point of 
the ring (Note: All units are defined in microns)

Any function with an asterisk or  will accept numerical inputs, equations, and the use of 
user-defined parameters.  Clicking on the  icon will launch the Variables and Functions 
dialog which will allow parameters to be defined.  Details on the use of parameters in 
expressions or scripting can be found in the User's Reference Manual accessed through the 
help menu or by pressing F1.



•

•

Some controls consist of 2 fields and will hold the value of the sum of the two - Expression 
and Offset :

Expression - used to input either a numerical value or an expression, which can be an equation with 
user defined parameters. 
Offset - Only accepts a numerical value and is used to offset the expression.

If the given property of an object is modified through the editors using the mouse the 
modifications will be reflected in the Offset field.





OptiFDTD Documentation – Getting Started

Quick Start– 19

•
•

•
•
•

•

•

•

•

•
•
•

The Z center position is controlled by the Horizontal control
The X center position is controlled by the Vertical control.

The Major radius, Minor radius and Orientation angle can be defined in the same way.  The ring is an 
ellipse, having a major radius and a minor radius. 

Major radius specifies the major radius of the ring
Minor radius specifies the minor radius of the ring
Orientation angle specifies the angle between the major direction and the Z axis (in degrees).

The Width box controls the size of the ring, which is the distance between the outer edge and the 
inner edge of the ring. 

The Depth box controls the position of the ring in the Y dimension. 

The Profile combo box enables you to choose between the different material profiles defined in the 
Profiles and Materials editor.  More detailed explanations on the Ring waveguide and all other 
objects can be found in the User's Reference Manual.

3.6 Properties of the input source
Now that we have verified the material properties and the geometry of our simulation, we can 
check the properties of the light source.  The source is defined under the Sources node of the 
project browser. You can define as many sources as needed. They can be of four types:

Z-direction Input Plane -  The light intensity distribution is defined across an incident plane oriented in the X-Y 
plane, light propagates in the Z direction
X-direction Input Plane (2D) - The light intensity distribution is defined along a line parallel to the Z axis, light 
propagates in the X direction.  NOTE: this source is only implemented for 2D simulations.
Point-source - Light is emitted in every direction (spherical waves) from a source point which is the excitation of 
a single mesh point.  Polarization options include Ey (2D TE), Hy (2D TM), or any E field component (3D). 

Additionally the user can specify the transverse field distribution along the input plane:
Modal - The field is calculated from the OptiMode mode solver.  The user can select the desired waveguide that 
intersects the input plane and the solver will use the cross-section of this waveguide for mode calculations.
Gaussian - Standard Gaussian distribution.
Rectangular - Distribution follows a rectangular transverse profile.
User-defined - Field profiles from other software packages such as OptiBPM or third party tools can be 
imported and injected through the input plane.

Finally, a source can be defined as either a continuous wave (CW) source, with a fixed wavelength or 
frequency, or as a Sine-Modulated Gaussian Pulse (SMGP). The SMGP is a convolution of a CW light 
source and a Gaussian envelope function, giving the signal a pulse shape and time dependence and 
in turn a range of frequency components.



OptiFDTD Documentation – Getting Started

Quick Start– 20

•

3.6.1 Geometrical parameters of the source
To verify the geometrical parameters of the source used, proceed as follows:

Double-click on the node named InputPlane1 in the Project browser.

8 Input Field properties dialog

In this Input Field Properties dialog, you can define the type of excitation (Continuous Wave or Sine-
Modulated Gaussian Pulse), the light distribution model for the plane (in the case of this example, 
Modal), and the position of the plane in the Z-direction. 

3.6.2 Transverse spatial distribution of the source
The properties of the transverse distribution can be accessed by doing the following:
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4.

5.
6.

Click on the tab labeled "2D Transverse".  Similarly "3D transverse" would be used for a 3D simulation

9 2D Transverse tab
For the ring resonator example, it can be observed that there are no entries in the Selected 
Waveguides or Selected Modes windows.  It is necessary to calculate the modes and then select the 
desired ones for the 2D transverse plane. To do so:

Click the Find Modes... button to open the mode 2D solver
In the Select waveguides for mode calculating list, select only the waveguide labeled Linear1.
Click the Calculate Mode button to solve the modes of the waveguide cross-section. Any modes supported 
will be displayed.
Click the checkbox next to Mode No. 0 to display the mode intensity distribution. The graph window 
updates to show the mode and geometry of the waveguide, as seen below.
Click Apply Data to apply the selected mode to the input source.
Click OK to close the Input field properties.
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In the Mode Solver, you can modify parameters such as polarization, number of modes to find and 
sampling in the Parameters tab.

10 Calculated Mode (2D Mode Solver)

Now the 2D Transverse dialog box includes a selected mode (this is the mode that will be used for 
the simulation):
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11 2D Transverse tab (with selected mode)

3.6.3 Temporal definition of the source
To review the temporal definition of the source (which in this case is selected to be Sine-Modulated 
Gaussian Pulse - SMGP), perform the following:

Click on the tab labeled Sine-Modulated Gaussian Pulse.  NOTE: This is only present if the Sine-Modulated 
Gaussian Pulse option is selected.
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12 Sine-Modulated Gaussian Pulse tab

In this tab, the settings for the time and frequency domains for the Gaussian pulse can be set and 
graphs of both domains are presented. The Wavelength of the modulated signal has been set to 1.5 
um and the time domain parameters FWHM and Time Delay have been automatically calculated (by 
checking the Default Value check box).  These quantities can be user specified. Based on these 
settings, the spectral characteristics of the SMGP can be verified. For this design the Center 
Frequency  of the SMGP, controlled by the source wavelength, is 199.862 THz and the FWHM (THz), 
controlled by the FWHM field, is approximately 133 THz. In depth details about defining sources can 
be found in the "Technical Background".

Full zoom and pan capabilities are available for both the Time Series  and Spectrum  through the 
right-click  context menu. If you zoom in on the time series window, you will notice that the 

It is important to ensure that the pulse waveform has both a smooth turn-on and turn-off. 
This ensures that higher frequency components (resulting from rapid amplitude changes) 
are kept to a minimum.
If uncertain then the Default Value, obtained by selecting the checkbox, will ensure that this 
condition is met as well as the largest bandwidth possible for the given wavelength.
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amplitude of light is asymptotically zero at the origin.  (Double clicking in zoom mode will return the 
view to the original size).

3.7 Detector properties
The detectors in use for the example are listed under the Detectors node of the Project browser. 
While there is no upper limit on the number of detectors that can be used, it should be noted that 
the storing and processing of each detector will add overhead both in terms of memory 
requirements as well as the time the simulation takes. There are 3 classes of detectors:

Observation Points - Used to record time varying field data from a single point in the simulation space. Spectral 
information can be extracted through post-processing and using a Discrete Fourier Transform (DFT) on the time 
data.
Observation Lines (2D) - Observations are only available in 2D simulations and can be positioned along either 
the X or Z direction and the spectral information at each point on this line will be stored.
Observation Areas (3D) - Observation planes are only available in 3D simulations and can be positioned along 
any XY, XZ, or YZ plane the spectral information each point in this area is stored. The result is a 2D graph that 
presents the DFT amplitudes across the observation area for a given frequency.  The OptiFDTD Analyzer will allow 
the user to select what frequency they are looking at.  A movie of the time varying amplitude for given 
components across the observation plane can be recorded during the simulation. 

To access the Observation Point located on the right side of the upper waveguide for the ring 
design, do the following:

Double-click the top-left small green dot in the design

OR
Double-click the ObservationPoint1 node in the project browser.



OptiFDTD Documentation – Getting Started

Quick Start– 26

13 Observation Properties – Point dialog

The position of the observation point is defined in the same way as sources. in this example the 
detector is positioned at coordinates Z = 13 um and X = 2.8 um.

3.7.1 Setting up data components and dynamic visualization of results
All detectors (Observation points, lines and areas) include a Data Components tab which allows the 
user to specify which fields to include (and save) at the various detection locations during the 
simulation. To include a specific field, check the box next to the field name (Ex, Ey, Hx, Hy, etc). All 
selected Data Component fields will then be made available for analysis after the completion of the 
simulation.

It is possible to directly observe, in a dynamic way, the optical field during the simulation run time. 
This feature, called Runtime Field View, provides the ability to access and view the spatial field 
components for the current simulation time steps. Temporary observers can be specified, but it 
should be noted that when observing predefined detectors only pre-selected field components will 
be available for visualization during the simulation.
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14 Observation Properties Data Components tab

3.7.2 Recording field data from an area detector (movie files)
As previously noted OptiFDTD can save a movie recording of the specified time varying field 
components for any Observation area. To setup the data components for recording do the 
following:

Double-click on Detectors/ObservationArea1 in the Project browser (recording can only be setup from 
Observation areas).
Select the Recording Data Components tab
Check the field component that the recording is required.  For this 2D TE simulation select the Ey field 
component box.
Select OK
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15 Recording Data Components

Each selected component will have its own movie file.  The filename format for movie files is 
[<Name  of the layout file>_<Name of the observation area>_<Name of the component>.avi]. In this 
example the movie for the Ey component would be stored as “Test_ObservationArea1_Ey.avi”.

3.8 Running a 2D simulation
In order to run the simulation, OptiFDTD will need to write temporary and result files to disk and as 
such it is necessary that write access is granted for the location that the project file is saved.  For 
example, saving a project file to the c:\ drive is not advisable as users do not typically have write 
access. The file must be saved in order to the simulation to complete

 Depending on the size of the area detector and the number of the selected field 
components,  recording component data into movies can significantly degrade the 
efficiency of the simulation and increase the time a simulation takes as well as the amount 
of resources required.   It is necessary to ensure that that there is enough free space on the 
hard disk for storing the movies.
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Select File > Save As... in the menu bar and choose an appropriate folder (for example My Documents) and 
filename before clicking Save.

Setting up the parameters and running the simulation are both accomplished through the 2D 
Simulation Parameters dialog.

Double-click on the 2D simulation... node in the project browser.

OR
Select Simulation > Simulate 2D...

16  2D Simulation Parameters dialog

The 2D Simulation Parameters (or 3D) dialogs control all parameters that affect the simulation, such 
as discretization and boundary conditions:
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a.

b.

Type of simulation - The 2D simulation can be setup to analyze the TE (transverse electric - Ey, Hx, and Hz) or TM
(transverse magnetic - Hy, Ex, and Ez) fields. For the purpose of this example the TE mode simulation is selected, 
this also happens to be the default for any 2D simulation.
Mesh parameters - The mesh parameters define the spatial resolution of used to discretize the simulation 
domain. The mesh delta can be defined separately for the X and Z directions and by default (activated by 
checking the Auto option) to , where  is the central wavelength of the source, defined by the Key Input 
Information drop down, in the material with the highest refractive index. While this ensures stability in the 
numerical calculations for the source it does not ensure that the physical dimensions are properly discretized.  A 
general suggestion is to apply the 1/10 rule of thumb to the smallest feature size as well as the wavelength.  
Convergence testing is also highly encouraged.  For the purposes of this simulation the mesh will be a square 
mesh of size 0.04 microns (X) by 0.04 microns (Z). The total number of associated mesh cells (which will 
encompass our simulation region) are automatically calculated based on the defined dimensions of the 2D 
wafer. Further information can be found in the Discretization section of the "Technical Background" manual.
Time parameters - are two controls which set the Time Step Size and the number of time steps, labelled Run for:

Time Step Size defines the time-domain resolution of the simulation. It is initially recommended to set 
this parameter to Auto (when Set to Auto, the time step size will be set to a level well within the defined 
limits of the Courant-Friedrichs-Levy (CFL) condition - see the Space and Time Steps section of the 
"Technical Background" manual.
Run for is the number of time steps that the simulation will be run for.  The Auto setting will set this to a 
value that should normally provide a steady state solution which is based on the time it would take light 
travelling through the design's highest refractive index material to travel from one corner of the 
simulation domain to the opposing corner. However depending on the type and complexity of the design 
(especially for designs which include resonant cavities or rings) additional time steps may be required 
before reaching a steady state solution. It is thus recommended to run additional simulations with a 
larger number of time steps and to compare the simulation results to ensure that the design has 
converged to a stable solution.
NOTE - When the source selected as the Key Input Information source is set to CW, additional steps will be 
performed (4 wavelength cycles) after the final time step to capture the DFT of the propagating field (this 
stage is called finalization of results). When the input field source is set to SMGP, the additional 
finalization step is not necessary and the DFT will be applied to all the time steps in the simulation.

DFT Spectrum - The DFT Spectrum button provides access to the DFT simulation parameter settings. Here the 
start and end wavelengths and the number of wavelength samples that are to be used for the simulation are set. 
These settings are important for Observation Lines and Observation Areas as this DFT data is captured during 
the simulation, note that this means that the specifications for the spectral range cannot be changed in post-
processing after the simulation has completed. Observation points are exempt from this limitation as they store 
the time-series data and as such DFTs can be performed at the users request.
Time Sampling Period - The Time Sampling Period is used to define the desired sampling rate for the Fourier 
domain analysis of Observation Lines and Observation Areas. By default the time sampling period is set to 1 
(recommended setting), meaning that the DFT is calculated at every time step of the simulation. If a value higher 
than 1 is used, the sampling period is increased (resulting in fewer sampling points or lower frequency resolution 
for the simulation).

Launch the simulation by clicking Run...
The Simulator window appears and the simulation is performed
When prompted, select Yes to open the Analyzer
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3.8.1 Viewing the simulation real time with the Run Time Viewer
During the simulation the runtime field view can be used to monitor the progress of the simulation. 
To do so, proceed as follows:

Left-click on Runtime Field View on the top menu bar of the Simulator progress dialog box
Select Use a Pre-defined Observer in Layout
Left-click on ObservationArea1 in the tree view
Left-click on Ey and select OK

The 2D profile of the mode field propagation will appear as follows:

17  2D Image Map

  Please note that the system needs resources and time to process all windows for the
Runtime Field View, as a result the simulation will be slower while the runtime viewer is 
being accessed and viewed.
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As the simulation progresses the window will update as the simulation progresses.  Simulations can 
be paused and resumed by clicking  the Pause  in the Simulator progress dialog box.  The viewing 
options for the viewer can be changed through the right-click context menu within the viewer.  For 
example if Height Plot is selected the field will be presented in a 3D format.

18  Height plot

For further information on the runtime Field View please see "Design Tutor" and Simulation under 
the help menu.

3.9 Analyzing the results
The data resulting from a simulation is stored in a separate file from the design.  The file name will 
be the same as that of the project and have an fda extension. All the simulation results are housed 
in this file (for further analysis at any time). The analysis of this data is done through OptiFDTD 
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Analyer. The first tab in the Analyzer window is a read-only copy of the layout.  It is provided as a 
reminder of the structure that was used for the simulation:

19 Analyzer window

The geometry of the design can be reviewed in the Layout or 3D Layout  views tabs.  The refractive 
index distribution can also be seen in the Refr_Idx tab. 

The detector data can be accessed by the following action:

Click on desired observation point located in the Results > Observation Points node in the Project Browser. 
As this is a observation point the field as a function of time will be displaced in the window.  Holding the 
Shift key while selecting will allow the user to select multiple observation points and have the results to be 
shown on the same graph.

3.9.1 Observing the time series data

If you use an anisotropic material in your simulation, you can change the component 
displayed in the refractive index view by going to View > Visualizer Data  and choosing the 
appropriate component.
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20 Observation Point Analysis dialog

It can be seen that the output as measured at the observation points located at the output ports of 
the ring resonator are decaying.  The source was a pulse and this decay is the light slowly 
propagating through the resonant structure.

3.9.2 Extracting spectral information
Using the Discrete Fourier Transform (DFT), it is possible to extract the spectrum from the time 
dependent field. To do this, follow these steps:

Select the pull down menu arrow next to the T icon on the Frequency tool bar:

Left-click to select the menu item "Frequency domain". The tool bar will update as follows:

Left-click

theDFT Specification
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icon,

, launching the dialog to control the bounds of the spectrum as well as the number of sample points. Set

theSample Points

to 1000.

21 DFT spectrum of the point detectors

The characteristic spectrum of a ring resonator is now visible.  The dips and the peaks of the the two 
curves represent the resonant wavelengths of the ring design which correspond to wavelengths 
where the waveguide mode couples to the mode in the ring resonator.
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A user may wish to normalize the results to a source.  this can be done by selecting the "N" button 
on the Normalization tool bar.  Additionally the source that is used for the normalization can be 
selected.

22 DFT spectrum of the point detectors (normalized)

3.9.3 Exporting the data to file
It may be desirable to export the data results for further analysis or use in external applications. To 
export the DFT spectrum for ObservationPoint2, it is necessary to do the following:

Click on the blue-grey folder icon,  , in the top left corner of the 2D graph window
Select Export Data... from the pull down menu
In the Data Export dialog box, select the ObservationPoint2 curve from the Curve combo box
Click Export Curve...
In the Save As dialog box, select a path and a file name.
Click Save
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3.9.4 Observing the 2D observation area results
To view results from an Observation area detector, do the following:

Click on desired observation area located in the Results > Observation Areas node in the Project Browser. 
For the purpose of this example select ObservationArea1.

The field propagation data for the Ey component will be displayed (by default the central 
wavelength setting for the SMGP is shown - 1.5 um in our case).  As this was a 2D TE simulation there 
are only 3 field components (Ey, Hx, and Hz) and only the Ey component is available as the was the 
only component selected for this observation area in the design.  Additionally, the components of 
the Poynting vector will be available if they were selected by the user during the design stage.

23 Observation Area Results

As the Observation area provides information in the spectral domain and the source was multi-
wavelength (a Gaussian pulse) it is possible to view the field information for multiple wavelength 
sampling points based on the DFT settings that were set in the simulation parameters. To change 
the wavelength sampling point,  left-click  on the pull-down menu of the frequency tool bar and 
scroll to select the desired wavelength, for example  1.577433 um.  This wavelength is chose as it is 
close to one of the resonant peaks observed from the DFT analysis of the point detectors. For this 
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wavelength the observation area shows that the majority of the waveguide mode field is coupled 
into the ring and exits from the lower left waveguide:

24 Observation Area Results (Resonance wavelength)

3.9.5 Observing the 2D observation area results (movie)
Recall that the observation area was set to record the time varying Ey component.  To view a movie 
recording of an Observation area detector:

Open the folder where "Getting Started Ring Resonator.fda" has been saved, the default location is the 
same folder that stores the main project file
Find the file named "Getting Started Ring Resonator_ObservationArea1_Ey.avi"
Right-click on the file and select "Open with/Windows Media Player"
A movie showing the progression of the time series field propagation (for Ey) will be shown

3.10 Working with the 3D editor
When working on a 3D simulation, you can view the 2D X-Z view from the Layout Editor (which is 
displayed by default) or you can use the 3D Editor (which is better suited to view and select objects 
in a 3D environment).
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25 The 3D editor

The 3D editor can be accessed by selecting  the 3D Editor  tab ( ) 
from the tabs that run along the bottom left hand corner of the viewer window.  In this view the full 
3D simulation domain is displayed along with all of the objects that make up the design. The 
coordinate system axes are indicated in the bottom left corner indication the orientation of the 
current view in 3D space.

3.10.1 Available 3D Views
The 3D editor toolbar comes with a range of viewing options:
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26 

3D view
Orthographic projections

XZ (Same view as Layout)
XY
YZ

 Quadrant view, 4Q, showing the 3D view and the three orthographic projections in the 4 quadrants
Wireframe view toggles whether objects are presented using facets or wireframes.  This view mode is available in 
any of the 3D views.

3.10.2 Mouse Navigation
The mouse can be used to orient the view in the 3D viewer:

27 Mouse Operations

To rotate, hold the left mouse button while moving the mouse to the desired direction. the axes of rotation 
can be changed by holding down the CTRL key prior to and during a rotation.
Zooming in the 3D viewer is done by scrolling the wheel forward to zoom in, and scrolling it backward to 
zoom out.
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• If lateral or vertical movement (panning) is necessary this is accomplished by holding the right mouse button 
while moving the mouse in the desired direction.

3.10.3 Selecting objects in the 3D view
In the 3D View, an individual object can be selected directly by left-clicking on it. It will become red 
and a grey box will be displayed around its name in the project browser.  in the OptiFDTD Designer, 
double-clicking an object in the Project Browser will pop-up its properties dialog box, and its 
geometry can be modified more precisely, or a new material can be assigned to it.
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